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Introduction

The LMIPA toolbox was developed by the Computer Process Control Group at the
University of Alberta to allow linear-matrix-inequality-based economic assessment of controller
performance using MATLAB.

A “Quick Start” approach to using this toolbox will be presented, along with a detailed

section containing a full explanations and examples for using this section.

System Requirements

In order to run this toolbox properly, the following programmes are required:

1) MATLAB 2007b (MATLAB 7.1) or lower. It should be noted that, since the binary files
have not been recompiled for the newest version of MATLAB, the programme will not
run on MATLAB 2008a.

2) The SYSTEM IDENTIFICATION TOOLBOX from MATLAB is required.

Quick Start

For quickly using the toolbox, the following steps should be followed:

1) Unzip the files to the desired location.

2) In the unzipped files, there is a folder called SolverTools. This folder, along with any
subfolders, must be added to the default paths in MATLAB. This is performed as
follows:

a. Start MATLAB.

b. Go to File=>Set Path.

c. A “Set Path” Window (Figure 1b) will appear. Click the button “Add with
subfolders”. Its location is shown by a box with the label 1 in Figure 1b. Find the
folder “SolverTools” and select it. Click “OK”.

d. Once MATLAB has finished, click on the “Save” button on the “Set Path”
window to save the new default paths. Its location is shown by a box with the
label 2 in Figure 1b.

e. The default paths are those paths that MATLAB will search to find a given

function.
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Figure 1: The steps required to add default paths in MATLAB. a) location of the "Set Path" command and b) the "Set Path"

Window

3) Inorder to use the software, point the current directory to the location of the unzipped

files.

4) At the command prompt, type “>> main_Imipa” to start
in Figure 2 should appear.

5) Press the “LMIPA” menu. A new GUI will appear that is sh

) MVPA - Limited Trial Yersion

the toolbox. The GUI shown

own in Figure 3.
oKX

LMIPA  Exit

LMIPA

LMI-based Economic
Performance Assessment
of MPC Applications

Limited Trial Version

Developed by
Computer Process Contral Group

Department of Chemical and Materials Engineering, University of Alberta

arsion 3.2 Copyright 2000-2007, University of Alherta

Figure 2: The First GUI that appears
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Figure 3: The main GUI for this toolbox, with the main regions highlighted

For the purpose of this quick start, we will be using the sample data provided in the zip
file. Go to the “Model” Menu located in the Main Menu area, which is denoted as 1

in Figure 3. Select the “Case_Model.mat” file. Be patient as the file is loaded. This file
contains the open-loop, process transfer function or the gain matrix. Then go to the “Data”
Menu located in the same area. Select the “Case_Cmprhnsv_Data.mat” file. Wait
patiently as the file is loaded.

After a few seconds, the data should be loaded. In order to see a plot of the data, go to the
“Open window” button located in area 3 of Figure 3. The resulting window is shown

in Figure 4. The abbreviations used in the graph are explained by clicking the “Legend”
button located in area 7 of Figure 4. The resulting window is shown in Figure 5. In this
case, none of the values will be changed. Thus, click the “Close” button located in area 7

of Figure 4.
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8) At this point, the “Run” menu is selected from area 1 of Figure 3. After a few minutes,

the screen-shot shown in Figure 6 will appear.
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Figure 6: Screen shot after clicking "Run"

9) The histogram located in area 2 of Figure 6 consists of 3 bars, which show the yield
potential under different conditions. The first bar shows the “ideal” yield potential, while
the second bar shows the actual (existing) benefit obtained using the given controller. As
well, actual benefit as a fraction of the ideal benefit is shown as a percentage. Finally, the
third bar shows the controller potential if the given reduction in variance can be reached
or if the constraints can be relaxed to the given value. Since in this example, no target




reductions or relaxations were given, this value is equal to zero. The actual values are
shown below the histogram.

10) In order to assess the model, given target reductions in the variance or relaxation of the
constraints, click on the “Open xls settings” button located in area 3 of Figure 3. This will

open an Excel spreadsheet, which is shown in Figure 7.
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Figure 7: Cropped view of the Excel spreadsheet

11) The spreadsheet shown in Figure 7 contains 4 columns:
a. Var. (%), which allows the user to set the percent reduction in the given variable,
b. Limit (%), which allows the user to set the percent relaxation in the given variable.
c. IsValid, which consists of 2 columns that determine whether or the given
variables are to be considered in the analysis.
It should be noted that the J-ratio represents what amount of the ideal benefit can is
desired, while A represents the linear weighting co-efficient.
12) For the purposes of this demonstration, it will be desired to examine which constraints
could be changed in order to achieve 60% of the ideal benefit potential. Enter the value
60 into cell D2 of the spreadsheet and click “Save” to save the results. If “save” is not
clicked, then the most recent results will not be used.
13) Click on the “Run” menu as before in order for the results to appear. The new results are
shown in Figure 8.
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Figure 8: Screen-shot after desiring a J 60% of the ideal

14) Figure 8 shows in the top histogram of area 4 (Output B), the amount of relaxation in the
limit values for the control (CV) and manipulated variables (MV). This can be toggled by
clicking the MV (or CV) button located to the right of the drop-down menu at the top of
the graph. In this example, approximately a 10% relaxation, that is an increase in the
upper limit, of the limit is required.

15) Next, sensitivity analysis will be performed to determine which variables, if any, are
sensitive to changes. This can be achieved by clicking the “Sensitivity Analysis”
checkbox that is located above the second histogram. After selecting it, press the “Run”

menu to obtain the results. The results are shown in Figure 9.
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Figure 9: Screen-shot after Sensitivity Analysis is performed

16) This suggests that manipulated variable 1 should be changed first to obtain the desired
change.

17) The results can be saved as a MATLAB file by clicking “Save,” which is located in the
Main Menu area. The programme can be quit by clicking on “Exit” twice to close the 2

windows that previously appeared.

Detailed Instructions

Theory
Linear Matrix Inequality Performance Analysis (LMIPA) is based on minimising the
economic objective function, J, that is (Lee, Huang, & Tamayo, 2008),
minJ (2.1)

where J is defined as



1 &
J =E§J(k) (2.2)

N, is the total number of data points collected, and J(k) is defined as

)4 _ _ 2 m _ _ 2

I =36, (05 +a ()(5 -2, ) |+ 3| 6,0+ O, -u, 1)) | @3

i=1 i=1
a, i1s the quadratic co-efficient for the i" control variable (CV), by is the linear co-efficient for the
i" control variable, a, is the quadratic co-efficient for the /" manipulated variable (MV), b, is the
linear co-efficient for the j‘h manipulated variable, y; is the set point (target) value for the control
variable, u is the set point (target) value for the manipulated variable, y and u are the optimal
mean operating points of the control and manipulated variables, p is the number of control
variables, and m is the number of manipulated variables. The optimisation is performed subject

to the following constraints:

> KA, =AY, Vi=12,.,p
j=1
L, (k)= (k)+20, (1+v,)<y, <H (k)+up,a, (k)-20, (1+v,) Vi=12,...p (2.4)
Lu/_ (k)— /1u/_ a, (k) + ZO'u/_ <u; < Hu/_ (k) + M, (k)— ZO'u/ Vi=L12,...m
where
1 &
¥, =¥, + 47, Vo, =D Vo (k) Vi=12,..,p
NL k=1
- (2.5)
i, =i, +Ai,, iy, =— > u, (k) Vi=12,...m
/ J J NL ) J

¥, and u,are the current mean operating points of the control and manipulated variables and y

and u are the routine operating process data, Ay, and A, are the proposed shift in the mean

operating conditions, L(k) is the lower limit (LL) for the given variable, H(k) is the upper limit

for the given variable, « is half the constraint region for the given variable, ¢ is the standard

deviation for the variable, v is the percent change in variability, x is the percent change in the

upper limit, and 4 is the percent change in the lower limit. The last 3 variables are set by the user.
Based on the above equations, 3 special cases are distinguished:

1) Base Case Operation, Jo: This is calculated by replacing y, with ¥, and u; with Uy -

This gives the base case potential.
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2) Ideal Benefit Potential, AJ, : Itisassumed thatv;=-1, 4, =, :;tuj_ =4, =0,
Vi=12,..,pand Vj=12,..,m. This gives the benefit, J;, for the case where there is no
process variability. The ideal benefit potential is then found as AJ, =J, - J,,.

3) Current (existing) Benefit Potential, AJ,: It is assumed that v; = 0,

/1%_ =H, :luj =M, =0, Vi=12,..,pand Vj=12,...,m. It should be noted that if

constraints (2.4b) and (2.4c) become unfeasible, then they are replaced as follows. For

constraint (2.4b), replace it by ¥, =y, or Ay, =0, while for constraint (2.4c), replace it
by u, = o, OF Au; =0. This gives the benefit, J, for the case where there are no changes

in either process variability or the constraints. The real benefit potential is then found as

Ap=J,-J,.

In practice, it is desired to see which variables should be tuned to achieve the given goals.
Thus, there is a need to perform sensitivity analysis. The brute force method would be consider
each of the variables separately, perturb it, and observe the results. However, this naive method
fails for 2 reasons. Firstly, it is assumed that the interaction between the variables is nonexistent.
Thus, there is no need to consider groups of variables (cross-terms). In practice, the individual
variables can strongly influence each other. Secondly, for a large number of variables, this search
would take too long to perform. Therefore, 2 separate algorithms have been developed that seek
to determine the sensitivities.

The first algorithm is used to determine sensitivity analysis for constraint tuning. In this

case, the following set of equations is solved (Lee, Huang, & Tamayo, 2008):

- /I;n;,rl Ny (IZ::/IM +u, + ,Z_; Ay U, J (2.6)
subject to
{/Ty 24,20 flag, =1 27)
A, =0 flag, =0
{ﬁy 2p, 20 flag, = 28)
u, =0 flag, =0



L (k)-A,a, (kK)+20, <y, <H, (k)+up a, (k)-20,
L, (k)— ﬂ’u]-auj (k) + 26ul_ <u, < Hu, (k) + Mo, (k)— ZGuj

Vi=12,...p
Vi=L12,...m

11

(2.9)

(2.10)

(2.11)

(2.12)

where A represents the given constant upper bound for the variable A, & represents the given

constant upper bound for the variable u, flag is a binary variable that represents whether or not

the given variables bounds can be changed, and R is the given target benefit potential ratio

which has a value between 0 and 1.

The second algorithm is used to perform sensitivity analysis for variability tuning. In this

case, the following set of equations is solved (Lee, Huang, & Tamayo, 2008):
. )4
min (ZI%I]
Foll; v b\ i=L
subject to
v, <v, <0 flag, =1
v.=0 flag, =0

L (k)-4,a, (k)+20, (1+ vl.) <y, <H, (k)+p,a, (k)-20, (l+ v, )
L, (k)- A, 2, (k) + 20, <u,<H, (k) + M, 2, (k) - 20,

Vi=12,..,p
Vji=12,..,m

where v represents the given constant lower bound for the variable v .

(2.13)

(2.14)

(2.11)

(2.12)
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Data Storage

For LMIPA, the comprehensive data storage format must be used. For quick generation

of the comprehensive data storage objects, the file “gen_cmprhnsv_Data.p” can be used.

Model Storage Format

The model storage file contains information about the multivariate model that is being

used to describe the system. It must be entered as a transfer function object (tf). This matrix can

be created using the following steps:

1) Assume that a process with » inputs and m outputs is being analysed. The transfer

2)

function between the /" input and the /" output is a rational function of either s or z, given
as A;; | B;, where A4 is the numerator and B is the denominator. Let 4 be a row vector
containing in descending order of powers of s or z the corresponding co-efficients of the
numerator 4. Similarly, let B’ be the corresponding row vector of co-efficients of s or z
for the denominator.

It is now necessary to create 2 cell arrays that contain all the information about the
process. The first cell array, A, is created as follows:

A:{Ail’Al‘Z"”’A‘

1n?

A211 22,...1A2n;

A Ay 4}
The first row contains the transfer function between the first output and each of the
inputs, while the second row contains the transfer function between the second output
and each of the inputs. It should be noted that the curly brackets, {}, are used to create a
cell array. In order to access, the (i, ;) entry of the array, the command would be A{i, ;}.
A similar cell array containing the values of the denominator, denoted as B, is also

created.

3) The time delay for the model can be created by forming the matrix D , such that the (i, /)

entry contains the time delay associated with the transfer function for the i output and ;"

input. The array simply contains the numeric values.

4) The continuous transfer object can then be created using the following MATLAB

command: “>>Atf=tf(A,B, >1oDelay”,D)”, where A is the cell array A, B is the
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cell array B, and D is the time-delay matrix, I . To create a discrete time transfer
function, the MATLAB command would be “>>Atf=tf(A,B,Ts, 1oDelay’,D)”,
where Ts is the sampling time. If it is desired to create a discrete model that contains

"1 then the command would be

powers of “z
“>>Atf=tf(A,B,Ts,’10Delay”,D, *Variable”,”z"-17)”

5) If a gain matrix is being used, then the transfer function would simply consist of constant
co-efficients. This can be created in MATLAB by assigning a value of “1” to each of the

entries in B and the gain values would be the entries in A.

Output Data Storage Formats

The comprehensive data storage method must be used.

Comprehensive
Assume that there are p samples of output data with a total of 7 controlled variables and s
manipulated variables with a total of ¢ = 8 tags. In the comprehensive data storage method, the
data is stored as an object containing the following entries:

1) controller_Status: This is a p-by-1 double matrix that contains the status of each of the
controllers, where 1 represents a controller that is “on” and 0 represents a controller that
is “off.”

2) cell_char_TagList: This is a g(z + s5)-by-1 cell matrix that contains the name of each of
the tags that are presented in the process. The first ¢ tags represent the first variable,
while the next ¢ represent the second variable and so on. For this toolbox, the tags are
given as:

cell_char_TagList(1): This is the tag for the PV values.

o &

cell_char_TagL.ist(2): This is the tag for the low limits.
cell_char_TagList(3): This is the tag for the high limits.

o o

cell_char_TagL.ist(4): This is the tag for the soft low limits.
cell_char_TagL.ist(5): This is the tag for the soft high limits.
cell_char_TagL.ist(6): This is the tag for the linear optimisation co-efficients.

cell_char_TagList(7): This is the tag for the quadratic optimisation co-efficients.

o Q oo

cell_char_TagL.ist(8): This is the tag for the target values.
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3) cell_char_TimeStamp: This is a p-by-1 cell matrix that contains the time stamp for each
of the samples.

4) dbl_Comprehensive_Data: This is a p-by-¢(z + s) double matrix that contains the values
for each of the tags and sample periods. Each of the columns contains the data in the
same order as the cell_char_TagList cell array does.

5) dbl_SamplingTime: This is a scalar double that contains the sampling time for the
process.

6) int_CVNumber: This is a scalar integer that contains the number of controlled variables
in the process, that is, 7.

7) int_MVNumber: This is a scalar integer that contains the number of manipulated
variables in the process, that is, s.

8) status: This is a p-by-(s + #) double matrix that stores the data in the following manner:
The first ¢ columns contain the status of the controller variables, while the remaining s
columns contain the status of the manipulated variables. A value of 1 signifies that the

data is good.

Data Generation
The data storage files for multivariate analysis can be generated using the p-file
“gen_cmprhnsv_data.p”. The following steps should be followed to create a compact data set.

1) Start MATLAB and point the directory to the location of the above binary file.

2) At the command prompt create the following matrix, which contains the 3 samples of the
2 controlled variables: ““>> W=[1 2;3 4;5 6]".

3) It will be assumed for the sake of this example that the process to be entered can be
described as

23 2s+1
2 e 2 e
s +1 s +3s+1
5 —1s 4S —3s

—¢
s+1 s +3s+1

y:

Thus, the required arrays and matrices for the transfer function will be created as

follows:

a) Form the 4 A-matrices as “>>A11=[2.3]; Al2=[2 1]; A21=[5];
A22=[4 0];".
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b) Form the 4 B-matrices as “>>B11=[2 0 1]; B12=[1 3 1]; B21=[1 1];
B22=[1 3 1];".

c) Create the 4-cell array as “>>A={A11,A12;A21,A22};".

d) Create the B-cell array as “>>B={B11,B12;B21,B22};".

e) The time delay matrix can be created as “>>D=[5 1;1 3];”. It should be noted
that the negative signs in the time delay have been ignored.

f) The transfer function object is then created using the following command:
“Atf=tf(A,B, "1oDelay",D)”. The resulting transfer function should match
the one given above.

4) Type at the command prompt: ““>> gen_cmprhnsv_Data”. The following should

appear
Consider a process with m inputs and p outputs

1. p x m plant gain/continuous transfer
matrix/discrete transfer matrix

. Output data (y): N x p matrix

Input data (u): N x m matrix

. Sampling time

Low limit data: (p + m) x 1 vector

. High limit data: (p + m) x 1 vector

Linear coefficients: (p + m) x 1 vector
Quadratic coefficients: (p + m) x 1 vector

© 0 N o o b WDN

. Target coefficients: (p + m) x 1 vector

Gain/continuous transfer matrix/discrete transfer
matrix:

5) Type “Atf” or the name of the transfer function object that was created above, and press
enter. This is the transfer function object that contains the open-loop plant model or gain
matrix. For the gain matrix, it would be simply a transfer function with constant co-
efficients.

6) Next, type “W” and press enter. This is the sampled data matrix for the given process.
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7) Then, type “[0 1;0 1;0 1]” and press enter. This is the sampled input data matrix for the
given process.

8) Following this, type “0.1” and press enter. It will be assumed that the sampling time is
0.1 seconds.

9) Next, type “[0;0;0;0]” and press enter. It will be assumed that the lower limit is O for all
the process variables.

10) Then, type “[10;10;10;10]” and press enter. It will be assumed that the upper limit is 10
for all the process variables.

11) Following this, type “[1;1;1;1]” and press enter. It will be assumed that the linear co-
efficients are uniformly 1.

12) Next, type “[0.5;0.5;0.5;0.5]” and press enter. It will be assumed that the quadratic co-
efficients are uniformly 0.5.

13) Then, type “[0.75; 0.75; 0.75; 0.75] and press enter. It will be assumed that the target co-
efficients are uniformly 0.75.

14) Enter a name for the output data storage file, say, for example, “test_data.mat” and press
enter. It should be noted that files that have the same name as those currently
present in the directory will be overwritten without any warning.

15) Enter a name for the model storage file, say, for example, “test_model.mat” and press
enter. It should be noted that files that have the same name as those currently
present in the directory will be overwritten without any warning.

16) In order to view the results, type “>>1oad test_model .mat” followed by
“>>gys MPC_Model”. The results should be identical to that displayed below:

Transfer function from input 1 to output...
2.3
#1: exp(-5*s) * ------------

#2: exp(-1*s) * -----------
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Transfer function from input 2 to output...
2s+1
#1: exp(-1*s) * ------m-mmmmmmeo

N2+3s+1

#2: exp(-3*S) * ------mmmmmmee-
s"2+3s+1
17) In order to view the other file type “>>load test_data.mat”. This will load each

of the entries into the workspace of MATLAB. Entering the name of each of the entries

given below should give the same results as are presented in Table 1.

Table 1: Summary of the Parameters Generated using the "gen_cmprhnsv_Data" command

Entry Value

[1
1
1]
[cv1
'CVL.N(L)'
'‘CV1.N(2)
'CV1.X(17)
'CV1.X(18)'
'CV1.X(8)'
_ 'CV1.X(7)
cell_char_TagList
'CV1.X(9)
'CVv2'
'‘CV2.N(L)'
'‘CV2.N(2)'
'CV2.X(17)'
'CV2.X(18)'
'‘CV2.X(8)'

Controller_status
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cell_char_TimeStamp

dbl_Compact_Data

dbl_SamplingTime
int. CVNumber
int. MVNumber

status

'‘CV2.X(7)
'‘CV2.X(9)
‘MV1'
'MV1.N(1)'
'MV1.N(2)
'MV1.X(17)"
'‘MV1.X(18)'
'MV1.X(8)'
'MV1.X(7)'
'MV1.X(9)
‘MV2'
'MV2.N(2)'
'MV2.N(2)'
'MV2.X(17)"
'‘MV2.X(18)'
'MV2.X(8)'
'MV2.X(7)'
'MV2.X(9)]
It should give the current time incremented by
0.1,0.2,and 0.3
This matrix is too large to display here.

0.1000
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Using the Toolbox

Installation

The toolbox can be installed by first unzipping the files to any desired location. Next, the
“solverTools” must be added to the search paths of MATLAB. This can be accomplished in the
following steps:

a. Start MATLAB.

b. Go to File->Set Path.

c. A “Set Path” Window (Figure 10b) will appear. Click the button “Add with
subfolders”. Its location is shown by a box with the label 1 in Figure 10b. Find the
folder “SolverTools” and select it. Click “OK”.

d. Once MATLAB has finished, click on the “Save” button on the “Set Path”
window to save the new default paths. Its location is shown by a box with the
label 2 in Figure 10b.

e. The default paths are those paths that MATLAB will search to find a given

function.

J MATLAB 7.6.0 [R200Ba) =) Set Path
Edit Debug Parallel Deskbop

Al changes take effect immedistely.

Mew 4

Open. .. Chl+0 MATLAE search path:

Clase Command YWindaw Acied Folder I sesi - 2
) ChcoursestprojectPATS3 2\DataPreFrocessor

Import Data... Add with Subfolders .. ] ) ChocoursesiprojectPATS3. 2\DataPreparation

Save Workspace As... ) Chcourses\projectPATSS Mbdodel Generatar

e 1 ) Chcoursesiproject PATE3 2\ServerDataCollectol

—_—= ) ChcoursestprojectPATS3 2\SimDataGen

Preferences... ) ChcoursesiprojectPATS3. AASimulinkDataCollec

Page Setup. .. * [ CheoursesiprojectiPATSS 2cluster

BrirE. . ) Chcourses\project PATSS. Aeomrmonfun

) Chcoursesiproject PATES ZcommaonfuntAlgaritt

2 CheoursesiprojectiPATEI ZicommanfumiGLs
1 CehLoliconkral @EFEE ) ChcoursesiprojectPATS3. AcommonfumSolverT
2 .. Hpack\@tFdata|tf.m ) ChcoursesiprojectPATSS AcommonfurtSoleerT 2

A L R, HUN o T T ol o T LSRR P o T RO
3 StuffMvpalvline. m 2 < ;

4 Cih Ly StuffyMypalpast.m
e ] :

Figure 10: The steps required to add default paths in MATLAB. a) location of the "Set Path” command and b) the "Set Path™
Window

[ Save

Exit MATLAE a Chrl+
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Starting the Toolbox
The toolbox can be accessed from MATLAB using the following sequence of commands.

First MATLAB itself should be started and the directory pointed to the folder containing the files
for this toolbox. Next, at the command prompt, type “>> main_Imipa”. The GUI shown

in Figure 11 should appear. This GUI is the main access to the toolbox. To start a session of the
toolbox, click on the “UVPA” menu. This will bring up a new GUI, which is shown in Figure 12.
In Figure 12, each of the main parts of the GUI is highlighted and will be discussed separately.

) MYPA - Limited| Trial Version
LMIPA  Exit

LMIPA

LMI-based Economic
Performance Assessment
of MPC Applications

Limited Trial Version

Developed by

Computer Process Control Group
Cepartment of Chemical and Materials Engineering, University of Alberta

Yersion 3.2 Copyright 2000-2007, University of Alberta

Figure 11: The First GUI that appears
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Juew Model Data Run Save Help Ext |
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1. Main Menu

I

2. Output A

H3. User Input

4. Output B

Limited Trial Version
Yield Potential
1 - Sefting: Obj. Fun, Desired Yield, & Var LLirit Changes —
S’ L [[] User Defined Obj. Function
F I -
[ [Open s setting | or {mport xis setting |
e S
o
g 0.2 ] ] MYPA Potertial | MYPA mat file #
0 ideal  Existi Jv
al Xisting ar. _LMIPA Assistant .
L)
for plant data & constraints analysis
— 0 T T T T T T T T T
L
2
g m e
B e
;;‘ 0
[~ | 1 | | 1 | 1 | |
-100
1 2 3 4 5 3 7 8 9 10
{1 Sensttivity &nalysis
~ 0 T T T T T T T T T
S
@
E 7 T
t{ 1w
B 0 e
8 -100 | 1 | 1 1 | 1 | 1
1 2 3 4 5 6 £ ] 9 10

Figure 12: The main GUI for this toolbox, with the main regions highlighted

In-depth Discussion of the Toolbox

Section 1: Main Menu

A close-up of the Main Menu section is given in Figure 13. The Main Menu consists of

the following 7 areas:

1)

2)

3)
4)
5)
6)

New: Clicking this menu will clear all the data from the current GUI and allow the user to

restart the analysis from a clean layout.
Model: Clicking this menu will allow the user to select the open-loop model or

model file that will be used in the analysis.

gain

Data: Clicking this menu allows the user to load data in the comprehensive data format.

Run: Clicking this menu will cause the toolbox to analysis the data that has been selected.

Save: Clicking this menu will allow the current analysis to be saved as a “.mat”

file.

Help: Clicking this menu will allow the user to access help about using the toolbox.

Currently, this is not available.
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7) Exit: Clicking this menu will cause the toolbox to close.

J APC Economic Performance Analysis and Tuning

Mew Madel Data Run Save Help Exit
Figure 13: Close-up of the Main Menu
Section 2: Output A

In this section, the potential functions and their values are displayed. The value for each
of the functions is also given.

Section 3: User Input
Here the user can enter information about the process. There are 4 distinct areas for the
user to consider:

1) User Defined Objective Function: This allows the user to define the objective function
that will be used.

2) Open xls setting or Import xIs setting: This allows the user to enter the desired
percentage changes in variance or constraint relaxation. This is entered in a spreadsheet
that is shown in Figure 14. The “IsValid” column allows the user to determine whether
the given variable will be used in the optimisation. It can have only one of two values: 0

(do not consider) or 1 (consider).

A B C 0 E F
_R’ar.l:Fi-’:'.} IsValid  Limit (%) IsValid

J Ratio
Lambda
cWl
CW2
MWL
M2

Lo TR s T e T e T s R
=
Lo T s T o T o T s T

b TN I I I S T E R ST
=

Figure 14: Cropped view of the spreadsheet that appears

3) MVPA Potential: This allows the user to import an MVPA potential .mat file, which
contains the minimum variance performance indices. These values show whether or not
further control can be performed for the given variables.

4) LMIPA Assistant: This allows the user to select the data that will be used in the

analysis. Figure 15 shows the window that appears. It consists of 7 different areas:
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a. Main Menu (Section 1): This is the generic MATLAB menu and will not
concern us here.

b. Model Data (Section 2): This section contains information about the model, such
as the number of controlled and manipulated variables, sampling time, and
feasibility.

c. Time Sections (Section 3): This allows the user to select the time section of the
data that will be used. In this field, the user can specify what part of the total data
is to be used in the analysis. The format for this entry is “[start sample value, end
sample value]”. A comma must separate the 2 values and the end value must be
greater than the start value. As well, there must a sufficient number of data
samples in order for the computer to estimate a model. It is possible to try more
than 1 section simultaneously. Each sample section is separated by a semicolon (;).
For example “[1,100; 40, 500]” will consider 2 sections; the first ranging from
sample 1 to sample 100 and the second from sample 40 to sample 500. Clicking
“Display” will display the selected samples in the data plot area (Section 6).
“Apply” button must be pressed in order for the data to be saved.

d. Select Variables (Section 4): This drop-down menu allows the user to select
which variables will be displayed.

e. Data Selected (Section 5): This allows the user to select what aspect of the
selected variable is to be displayed. It can be noted that “std” represents the
standard deviation of the individual data. The data is displayed in the following
manners:

i. Histogram: The On/Off status and Std graphs.
ii. Line Graphs: The Data/Limit Range and all the individual CV values.

f. Data Display (Section 6): This displays the selected data. The abbreviations are
explained in Figure 16, which can be obtained by clicking the “Legend” button
located in Section 7.

g. Useful Buttons (Section 7): This contains 2 buttons that display the legend

(Legend) or close the given window (Close).
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J Plant Data & Constraint Analysis for LMIPA

1. Main Menu

ile  Edit “iew Insert Tools Deskbop Window Help |
P W& k AR ® & 08 6O

Flart Data & Model Info.————— W Opt. Feasihility

—2. Model Data

Time Section

W 2 Sampling Time (sec) 01 Existing “ield:
My 2 Variance: 3. Time Sections
Starting Time: 03-Mar-2007 132153 Lirmit:

“ar & Limit:

Ending Time:  03-Mar-2007 132333

' ' ' ' ' A. Select what variables
N I = | -
Dratairmit H
08 eTE——— are displayed.
St
ol s D Select what aspects
04| .
g oz} are displayed.
= of .
P 6. Display of the
S o4l Selected Data
-0E M
0.8 | i j
B - o

b
4] 100 200 200 400 500 500 700 00 200 104 w [m] < I7 USGfU| BUt'[OI’]S

Samples

Figure 15: Plant Data & Constraint Analysis for LMIPA

' Legend

— Legend
—_— Plant CW Y Signial
Plant Ideal Operation

Constraints
LIL Upper Limit
LL Loswer Limit

=-LIL Soft Upper Limit
=s-LL Soft Lowwer Limit
Existing Potential

»_upp  Upper Bound of
J_fow  Lowver Bound of y

u_upp | pper Bound of u

u_fow Lowwer Bound of u

— Time Section

1. Input [E_0, t_f].

2. Dizplay.

3. Apply.

4. Runin LMIPA, .

* To return, input [ ].

Figure 16: Explanation of the abbreviations used in the Plant Data & Constraint Analysis for LMIPA window
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Section 4: Output B
This section presents 2 graphs that present the results of the analysis by the toolbox. The
information above each of the 2 graphs, allows the user to:

1) Determine whether or not to perform sensitivity analysis (only over the second graph).
Checking the check box will select sensitivity analysis.

2) Determine what type of control analysis is being performed. The drop-box contains the
following entries: minimum tuning, limit relaxation, and variance reduction. Not all of
the selections are available at a given point.

3) Cycle between controlled (CV) and manipulated (MV) variables.

Examples
The following example will present how the analysis can be performed using MATLAB.
The example is based on the data provided in the unzipped folder, which consists of 2

manipulated variables and 2 control variables.

Part I: Using the Programme to Obtain the Results

Now, that it has been explained how to perform the calculations manually with minimal
computer help, the programme that was designed to do this will be explained. The first step is to
load the programme, “>>main_Imipa”, and click on “LMIPA” in the window that appears.

Next, load the model into the programme. This can be accomplished by clicking on the
Model Menu and selecting the “Case_model . mat” file.

After a few seconds, load the data by clicking the Data Menu and selecting the “Compact”

option. Select the file entitled “Case_Cmprhnsv_Data.mat”. Next, click on the “Run”

menu to obtain the screen shown in Figure 17.
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) APC Economic Performance Analysis and Tuning

Mew Model Data Run Sawe Help Exit
Limited Trial Version

Yield Potential
— Setting: Obj. Fun, Desired Yield, & Yar JLimit Changes —

=
=

......................... [] User Defined Ohj. Function

=
(4]

————————————————————————— [Open Wz zetting ] ar [Import xlz zetting ]

"""""""" WvPa& Potertial | MWPA mat file
0%

Ideal Existing JWar.

o
e

Unit of Benefit (§)
[ ]
ra

=

— LbIPA Assistant

(0.32526, 012662, 0) - . .
faor plant data & constraints analysis

] Ry

B i T T e T
. Uy
-100 1 1 1 1 1 1 1 1

G\ war. change (%)

1 ) .

B i T T e T
. Uy
-100 1 1 1 1 1 1 1 1

G\ war, change (%)

Figure 17: Screen shot 1 for the example

Figure 17 shows that the ideal benefit potential is 0.33, while the current (existing)
benefit potential is 0.13, or 38.9%, of the ideal.

Now click on the “Open xIs setting” button. It will be desired to see what constraint
relaxation needs to be performed in order to achieve 60% of the ideal benefit potential. In order
to do this, enter a value of 60 in D2 of the spreadsheet. Save the spreadsheet, or else the values
are not updated. Finally, click on the “Run” menu on the main window. The results shown

in Figure 18 should appear.
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J APC Economic Performance Analysis and Tuning
Mew Model Data Run Save Help  Exit

Limited Trial Yersion

Yield Fotential
T — Setting: Obj. Fun, Desired Yield, & “ar JLimit Changes —

[] User Defined Chj. Function
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=

Lnit of Benefit (§)
[}

Ideal Existing o Limit
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W limit change (%)

100 —
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Figure 18: Screen shot 2 for the example

From Figure 18, it can be seen that in order to achieve 60% of the ideal benefit potential,
the first control variable’s (CV) constraint needs to be increased by about 5%. It would now be
interesting to determine the sensitivity of the variables to a change. This can be accomplished by
selecting the “Sensitivity Analysis” check box, which is located just above the second graph.

Click on the “Run” menu to accomplish to obtain the results. Figure 19 shows the results.
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Mew Model Data Run Save Help  Exit
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Figure 19: Screenshot for example after performing sensitivity analysis

Based on Figure 19, it can be concluded that at minimum tuning the first control
variable’s constraint should be increased by approximately 5%.

Another possible approach is to determine how much the benefit potential can increase if
the variance is decreased by 60%. Thus, return to the Excel spreadsheet and enter zero in D2,
which previously contained 60. Now enter in B2 the value of 60. Save the spreadsheet. Return to
the main LMIPA GUI and press “Run”. The results are shown in Figure 20. The results suggest a
decrease of 60% in the overall variance will give a decrease of 40% in the variance of the first
control variable. Similarly to the above, it is possible to perform sensitivity analysis by clicking
the “Sensitivity Analysis” checkbox and pressing the “Run” Menu again. The results are shown

in Figure 21 and suggest that the process is quite sensitive to changes.
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Figure 20: Screenshot after performing variance reduction
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Figure 21: Screenshot of VVariance Reduction and Sensitivity Analysis



Part I1: Time Section in LMIPA
In order to enter time section in LMIPA, the following steps should be followed:
Click on the “LMIPA Assistant”.
Go to section 3 (Time Section) of Figure 15, and enter into the box: “[100, 500]”. Press

1)
2)

30

the “Display”, which is located below the box. Select “CV1” in section 4. The figure

shown in Figure 22 should appear. Other control variables and manipulated variables can

be selected. Once you have confirmed that the desired section has been selected. Click

the “Apply” button, which located in section 3 below the textbox. Finally, click on

“Close” button that is located in section 7 of Figure 15.

Controlled Warnabla

J Plant Data & Constraint Analysis for LMIPA - |I:I|§|
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v 2 Sampling Time (sec) 04 Existing “field: feasible
MY 2 “ariance: [100,500]
Starting Time: 05-Mar-2007 13.21:53 Litnit:
Ending Time: 05-Mar-2007 13:23:33 | | War & Limt: Display | | Aepky
T T T T T T T C\.-' A
= 0 )
Datadimit range A
4 |Snioff status
=ted
T2
- oo #1]a] h
LL sl L
| 1 1 1 1 | 1 1 b
0 100 200 300 400 L4]4] GO0 00 400 00 1000
Legend Cloze
Samples

0.4

08

0.4

0.2

0.2
-0.4
06 H

0.4 |

Figure 22: Showing the selected time sections for CV1

3) Click on the Run menu in the main window. After some time, the figure shown in Figure

23 should appear. As can be seen, the results are similar to those previously obtained.

This should be the case in most circumstances.
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Figure 23: Results after using a given time section
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